Analytical Hierarchical Process (AHP) Techniques and
Geospatial Technologies for Groundwater Potential
Zone Mapping

Abstract

Due to its consistent availability, acceptable natural quality, and ease of direct diversion. to the
underprivileged population, groundwater is a vital source of water supply.-It can also be
transported there more swiftly and inexpensively. Exploring groundwater potential zones
(GWPZs) maps is therefore essential, especially in semi-arid environments with insufficient
surface water supplies. The groundwater potential of the research. area is assessed using
geographic information system methods and remote sensing“data.~Operational Land Imager 8
data, digital elevation models, soil data, rainfall data, and dug-out-well data were utilized to
estimate the characteristics that influence groundwater potential and recharge zones. Maps of
lineament density, drainage density, rainfall -distribution, topographic-wetness index, land
use/land cover, land-surface temperature, slope and soil were produced. These were overlaid
based on analytical hierarchical process‘weightage prioritization at a constituency ratio of 0.05.
The resulting map was divided into-very high, high, moderate, low and very low groundwater
potential zones. The area dimensions.of these categories are 116005.5 ha, 35822.4 ha, 20152 ha,
2459 ha and 259245 respectively. Accordingly, the north-east part of the study area is expected
to have very high ground( 'water potential. Out of the 55 operational wells sampled, 72.73 %
were situated in areas with very high groundwater potential. The high category had 10.91%
while the moderate, low and very low categories remained 7.27%, 5.45% and 3.64%
respectively. The overall result indicates that the model approach is reliable and can be adopted

for a reliable characterization of GWPZs in any semi-arid/ arid environment.
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Introduction

One-third of all freshwater withdrawals worldwide come from groundwater [1]. In arid and semi-
arid nations with limited water supplies, it is an essential natural resource for any economic



growth [2]. Groundwater is a type of water resource that fills joints, voids, and pore spaces in
soil found within layers and geologic formations. The presence of groundwater in rocks depends
on the lithologic materials' hydraulic conductivity, which is a result of their porosity,
permeability, and fluid movement via geologic structures or apertures [3]. The water deficit is a
global issue because of the relationship between water, food, and energy and its influence as well
as the influence it has on human life and the world economy. Because of the nation's rapid
urbanization, population increase, and overall economic growth, Nigeria's need for groundwater
IS increasing. In the current research region, groundwater is also the most often used resource for
residential water supply, agriculture, and livestock. The scarcity of water may persist for.a longer
period of time in some regions in Nigeria due to the rate at which the population is-increasing,
the extent to which urbanization and farming activities are reliant on water<sources. Things get
more challenging due to climate change [4]. Data collection and assessment, the construction of
impoundments and water infrastructure for water transfer schemes, water regulations,
optimization programmes, and management strategies have all been part of arbitrary efforts to
ensure water security [5]. The documentation of groundwater-distribution. is relatively sketchy
[6]. Therefore, the goal of the current research is to increase knowledge of groundwater
availability and to give a strategy for mapping groundwater potential zones. Groundwater
potential zones (GWPZs) are regions that have a significant amount of commercially exploitable
groundwater resources. [7,8]. For the estimation-of water resource reserves, zone budgeting,
water quality protection, vulnerability mapping, .and_environmental management, GWPZ
exploration is crucial [7]. Various academics across the world have used the RS and GIS
techniques to designate groundwater potential zones. [9,10,11]. Geology, geomorphology
(landforms), slope, soil type, rainfall; land-use, and drainage characteristics are some of the
factors that are directly or indirectly related'to the research of the location of groundwater
potential utilizing RS and GIS [12]. The development of geoscientific data access and processing
skills, as well as the numerous geoinformatics applications, have recently made it possible to
regionally explore locations with potential for groundwater. A significant improvement has been
made as a result of the'widespread use of geospatial technology for GWPZ mapping, particularly
with the introduction of multi-criteria decision-making (MCDM) statistical classifier [13].
Weight of evidence, evidential belief [14], weighted overlay [15], multi-influencing factors [16],
analytical hierarchical process [17,18], logistic regression [19], and frequency ratio are a few
examples of statistical tools [20].

The analytical hierarchical process (AHP), among these, has been recognised as the best

effective method for making multi-criteria decisions [21]. Machine learning methods (MLT) for
resource'modelling have been made possible by the development of prediction modelling and the
advent of computer programming [22]. MLT's adaptability in the analysis of complex structures
and stochastic data has made groundwater resource exploration outcomes more dependable
[23,24,25]. In light of this, a number of MLT regression models for GWPZ mapping were
suggested. These include boosted regression tree [26,27], support vector machine [28,29],



artificial neural network [30,28], radial basis function, multiple-layer perception, standalone
logistic regression [31], and random forest [32,33]. Machine learning techniques are more
resilient than unsupervised statistical methods because of their accuracy, speed, ability to process
massive databases, and capacity for self-improvement [34]. Additionally, there has been a
notable increase in machine learning model performance. For instance, by combining a multi-
adaptive boosting model with logistic regression, [35] created the ensemble multi-adoptive
boosting logistic regression (MABLR) approach. Due to inadequate sample size, simplicity, and
outliers sensitivity, the model offers outstanding performance for groundwater aquifer:potential
maps for bias and variance error reduction [35]. For the evaluation of groundwater spring
potential zones, [36] combined an alternating decision tree classifier with an adaptive boosting
ensemble model to create the hybrid computational intelligence technique known as AB-
ADTree. In order to map the groundwater potential zone, [37] offer two data mining approaches
based on the use of mixed discriminant analysis and.linear discriminant analysis (LDA) in
comparison with random forest. By normalizing the 15 coenditioning factors in the variance
inflation factor, chi-square factor optimization,-and Gini importance, the duplication within the
groundwater conditioning factors was reduced. Their findings showed that, despite the random
forest approach's superior performance, the two.data mining strategies are acceptable and
moderate [37]. Additionally, [38] created a hybrid method for measuring the potential of
groundwater springs that combines Fisher's LDA, rotation forest LDA, and bagging LDA. The
ensemble learning model and MLT's meta-algorithm compartment, which make it easier to do
multivariate analysis on a large dataset, both increase the computing power of MLT [25]. While
the skewness and.operational complexity of MCDM statistics rise with the increase in
unpredictability.and sample size, MLT works by scientifically improving itself as sample
distribution, sizes, and randomness increase [34]. Seven datasets are utilised in this study to
evaluate their suitability for site-specific GWPZ investigation. AHP was used as the statistical
classifier since this study is more research-oriented than result-oriented. According to [39], there
are boreholes in the west of the research area that have been abandoned owing to the mechanical
failure of the borehole hardware. [39] also evaluated the variables impacting the
underdevelopment of groundwater and inadequate management of groundwater boreholes. The
assessment of groundwater potential zones based on the accumulation of statistically weighted
geoscientific layers within the research region is the main topic of the current work. In order to



determine their weightage prioritization at a catchment scale, seven thematic layers were
geospatially coordinated using AHP. These include the topographic wetness index (TWI), land
use/land cover (LULC), lineament density (LD), drainage density (DD), rainfall distribution
(RD), surficial lithology (SL), and land surface temperature (LST). According to the project's
goals, it is envisaged that the themes chosen would enhance how AHP is used to an integrated
strategy for groundwater investigation. One of the most popular multi-criteria decision-making
approaches is the analytical hierarchy process (AHP) approach [40]. In general, AHP is.regarded
as a straightforward, transparent, efficient, and dependable technique that may be utilized to
identify groundwater potential zones [13,41]. Therefore, the purpose of this work is to
demonstrate if it is feasible to create a high-precision map of the groundwater. potential zone for
a semi-arid environment. This strategy's justification is based on. the integrated water resources
management plan, which promotes the coordinated development of water resources in an
environmentally responsible manner [42]. The decision-makers, stakeholders, and the host
community at large would all gain greatly from the strategy proposed in this study. The results
are supported by the precise yield of the active boreholes and the volume of spring discharge in
the targeted locations. The major goal of this project is to map and identify groundwater potential
zones utilizing integrated methodologies that promote sustainable planning, development, and

use along with effective management:of groundwater for drinking and irrigation.

Materials and Methods

Study Area

Oke-Ogun region is the north-western area of Oyo State, and is made up of ten local government
areas In the=northern and north-western parts of Oyo State, Nigeria. Out of the ten local
Government areas, the three largest ones were selected for this study. They are Saki East, Atiba
and Orelope local government areas (LGA) (Map 1). It is located between Longitudes 3°10’and
4’25’ and Latitudes 7°55’and 8°50’.The soil types, are Clay loam, Concretionary clay, Loamy
fine sand, Sandy soil, Sandy clay, Sandy loam and Silty clay. Rainfall ranges between 646 mm
to 673 mm. the geology is basically of the basement complex rocks. The average temperature is

about 27°C. The inhabitants are predominantly Yorubas with other tribes like Igbos and



Hausa/Fulanis as minority tribes. Faming and pastoralism are the major economic activities in

the study area.
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Map 1: Map of the study area

Analytic Hierarchy Process (AHP)

For the purposeof creating the GWPZs map, the current study relies on the compilation of RS and GIS datasets.
Nine regulating factors (slope, drainage density, rainfall, lithology, soil characteristics, geomorphology units, land
use/land cover, lineament density, and distance to river) were utilized to define the GWPZs. By applying normalized
weights to assess the GWPZs of the basin, the AHP approach was used to examine the thematic maps of these
parameters. AHP application calls for scientific expertise, credible data, and an evaluation of matrix consistency [43,
44,45]. We applied the AHP approach in a scenario similar to [46] by (i) choosing the factors governing



groundwater recharge, (ii) generating a pairwise comparison matrix, (iii) allocating relative weights, and (iv)
assessing the consistency of the matrix (Figure 1).
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Figure 1: Flow Chart of the methodology adopted for this study

The pair-wise prioritizing method for calculating the weightage of features is made possible by
AHP. The characteristic vector of the square reciprocal matrix of paired features serves as the
basis for the scoring system for features' weights [47]. AHP has been effectively used in several
groundwater potential zone mapping projects as well as environmental management
[48,49,50,51,52].

Preparation and computation of the thematic layers

Land surface temperature
The LST theme was created from a download of the Landsat 8 Operational Land Imager from
the USGS Earth Explorer website on February 26, 2022. The:month is among the driest in the
entire year. The satellite data's bands 4, 5, and 10 were processed in the following order:
Equation 1 was used to determine the top of-atmospheric (TOA) spectral radiance using raster
algebra.

TOA = RE,, x TIRS 1 + RF, 1

where
RFM = radiometric multiplicative rescaling factor for TIRS 1 which is 0.0003342,
TIRS = thermal infrared sensor 1 which is Band 10, and

RFA = radiometric addictive rescaling factor for TIRS 1 which is 0.1.

TOA was converted to brightness temperature (BT) using Equation 2

Ky
BT = +———~——=—273:15 2

K;
|in (7e) + 1]
where K1 and K2 = Thermal conversion constant for Band 10 extracted from metadata and

273.15 constant for temperature conversion from Kelvin to Celsius.

NDVI was calculated using the expression in Equation 3



NDVI = NIR — RED 2
~ NIR +RED

where NIR (near-infrared) = band 5, and
red = band 4 for Landsat 8 OLI.

Vegetation proportion (P,) was calculated from NDVI, using Equation 4

__( NDVI-NDVIymin \?
k= (NDVImg_x—NDVImin) 4
Emissivity was calculated from Py, using Equation 5
£ =0.004 x P, + 0.986 5

where
0.004 is the downscaling constant for Pv and

0.986 is the correction value of the equation.

Soil Features
An aquifer's infiltration and percolation rates are significantly influenced by the soil [53]. The

vertical and lateral water movement can be significantly impacted by the size, shape, and
arrangement of the soil grains and the related pore system [54]. The soil map was downloaded
from the Food and Agriculture Organization's (FAO) Geo Network Web Portal for Soil Map
(http://www.fao.org/geonetwork/srv/en/metadata.show%3Fid=14116). We obtained information
from the "Digital-Soil Map of the World—ESRI Shapefile format" section of the FAO website.
Additionally, SWAT Soil Data (http://www.indiaremotesensing. com/p/s.html) was used to
determine soil “.classifications. ArcGIS 10.8.2 now includes a soil map that has been
georeferenced to the UTM projected coordinate system. Using the tools Analysis Tools > Extract
> Clip, we extracted the research area. The soil types on the map were then geo-coded at various
category levels in accordance with the classes derived from the SWAT Soil Data.

Rainfall



Rainfall, the primary source of groundwater recharge, has a significant influence in regulating
groundwater recharge, according to [55] of the Climate Research Unit (www.cru.uea.ac.uk/data).
To get rainfall data, we next chose "Main homepage for the high resolution gridded datasets."
Using the tool Multidimensional Tools > Make NetCDF Raster Layer, the rainfall data were
transformed into a raster layer. Then, we used the tools Conversion Tools > From Raster >
Raster to point to convert the raster layer to points. To create a rainfall contour map, these points
were interpolated using the Spatial Analyst Tools > Interpolation > Kriging tool. The Spatial
Analyst Tools > Extraction > Obtain by Mask tool was used to extract the rainfall map for the
research region. The normal kriging interpolation method and a linear .semi-variogram model
were used to calculate and estimate the yearly average rainfall in order to create a rainfall themed

layer. The resultant rainfall map, which varied geographically, was categorised for overlaying.

Land use/land cover

The map of the land use and land cover was created using ArcGIS 10.8.2, which was used to
analyse Landsat 8 OLI data that had less than 10% cloud coverage. The reflectance quality and
spectral distortion of the downloaded images were corrected. The LULC was created using this.
By creating a composite band from bands 1, 2, 3, 4, 5, 6, and 7, LULC was mapped.

Lineament density

Linear characteristics like fractures, faults, cleavages, and discontinuity surfaces are expressed by
lineaments, which..are linear properties. When a structure has pieces that are placed in a
rectangular or somewhat curved manner, differ from the arrangement of the neighbouring
features, or reflect some underlying characteristic, those parts are referred to as a lineament.
Lineaments can be simple or complicated. The 30-by-30-meter ASTER DEM was used to create
the surface lines. The hydrological algorithm in ArcGIS 10.8.2 was used to do this. High
lineament densities are a sign of high permeability zones, which make them suitable locations for
GWPZs [56]. Very high, high, moderate, low, and very low lineament density are the most
common categories. [57]. After adding the acquired map to ArcGIS, the lineament density was
calculated using the tools available under Spatial Analyst Tools > Density > Line Density.



ArcGIS 10.8.2's grid cells approach, which is based on Equation 6, was used to process its
density [50]:

-3 )on :

where

LD is the lineament density,

L; is the sum of the length of all the lineaments (km),
i represent each linear feature in the study area, and

A is the effective area of lineament cell grids (km?).

Drainage density

The total length of all stream segments in a region.divided by.its area is known as the drainage
density [58]. An excellent way to anticipate. infiltration-rates and highlight the relationship
between permeability and surface runoff in terrain is to look at the drainage density [59]. High
drainage density terrain has relatively-slow recharge rates, whereas low drainage density terrain
has faster recharge rates [60]. Poor GWPZ results from high drainage density since they are
conducive to runoff, and vice versa [9]. In the current study, the spatial analyst tools > density >
line density in ArcGIS 10.4.1 were used to compute the drainage density.

For the purpose of developing drainage density, the USGS Earth Explorer website's ASTER
Digital Elevation“Model (DEM) was downloaded (DD). The spatial analyzer of ArcGIS was
used to create the.drainage density map. The delineation of the watershed hydrological pattern is
therefore:made possible by the calculation of the effective area of drainage. Equation 7 was used
to obtain.the watershed's drainage density index.

D= the total length of channels
B A

where



DD means drainage density and
A is the area.

Slope

Groundwater recharge into aquifers is significantly influenced by local and regional relief, which
is represented by the slope [61]. The slope gradient, which is frequently utilized in the-definition
of GWPZs, directly regulates surface water infiltration [62,63]. Due to the greater drainage, an
area with a high slope gradient has a comparatively low GWP. However, a low slope gradient
restricts water flow, which increases the rate of infiltration [59]. Using:the tools found under
Spatial Analyst Tools > Surface > Slope in ArcGIS 10.8.2, we calculated the slope after
producing the DEM, drainage lines, and watershed border in Section 3.3:

Topographic wetness index

In ArcGIS 10.8.2, the slope map was created from which TWI was mapped. This was
accomplished by using Equations 8 and 9 to determine the rate of change of a cell grid aspect
within its neighbourhood [64].

_ a
TWI = In [mn o 8
=1
Where

alpha is the specific catchment area,
A is the catchment area,
L is the contour length, and

tan(p) is the slope.

Slope, elevation, and landform implications on groundwater development were integrated using

the TWI map [65]. In this computation, the effects of topographic roughness, hillslope, and



foothill on lateral groundwater flow are combined. The ability to identify areas of soil moisture
storage and infiltration potential unique to foothills is made possible by locations with high TWI
[66]. The use of a surficial lithology map in place of a traditional scanned geologic map is a

notable feature in the selection of the themes.

List 1: Demographic profile of the study

Factors | Weight | Rank Over All
Slope
0-1 5 100
1-2 4 80
2-5 20 3 60
5-14 2 40
14-38 1 20
Rainfall(mm/year)
646-650 4 100
650-659 3 75
659-668 25 2 50
668-673 1 25
Land Surface Temperature(°C)
18-24 1 10
24-26 2 20
26-29 10 3 30
29-36 4 40
Drainage Density(km/km?)

Very High 1 15
High 15 2 30
Low 3 45

Very Low 4 60

Lineament Density(km/km?)

Very High 4 20
High 5 3 15
Low 2 10

Very:Low 1 5

TWI

Very High 4 225
High 5 3 170
Low 2 10

Very Low 1 5

Soil
Clay-Loam 8 120
Concretionary Clay 4 60




Loamy Fine Sand 7 105
Sandy 15 6 90
Sandy-Clay 3 45
Sandy-Loam 5 75
Silty-Clay 1 15
LULC
Bare Land 1 5

Light Forest 5 2 10

Thick Forest 3 15

Water Body 4 20

Table 1. Groundwater potential prospect rainfall map.classes
Rainfall Classes(mm) Value (Rank) GWP Prospect Rank
646-650 1 Very Low
650-659 2 Low
659-668 3 High
668-673 4 Very High
Table 2. Groundwater potential prospect reclassified slope map information.

Slope Classes (Degree) Value (Rank) GWP Prospect Rank
27.7-75.9 1 Very Low
17.9-27.7 2 Low
10.4-17.9 3 Moderate
4.5-10.4 4 High

0-4.5 5 Very High
Table 3. Groundwater potential prospect reclassified drainage density map information
DD Classes (km/km?) Value (Rank) GWP Prospect Rank
1.3-1.8 1 Very Low
0.7-1.3 2 Low
0.4-0.7 3 High
0-0.4 4 Very High
Table 4."Groundwater potential prospect reclassified lineament density map information.
LD Classes (km/km?) Value (Rank) GWP Prospect Rank
0-0.4 1 Very Low
0.4-0.8 2 Low
0.8-1.6 3 High
1.6-2.7 4 Very High
Table 5. Groundwater potential prospect reclassified LULC map information.
Class Name Value (Rank) GWP Prospect Rank
Bare Land 1 Very Low
Light Forest 2 Low
Thick Forest 3 High
Water Body 4 Very High

Table 6. Groundwater potential prospect reclassified LST map information.




LST Classes

Value (Rank)

GWP Prospect Rank

18-24 1 Very Low
24-26 2 Low
26-29 3 High
29-36 4 Very High

Table 7. Groundwater potential prospect reclassified TWI map information.

TWI Classes Value (Rank) GWP Prospect Rank
1 Very Low
2 Low
3 High
4 Very'High

Multi-criteria decision analysis using GIS techniques:

The most popular and well-known GIS-based approach for defining groundwater potential zones
is multi-criteria decision analysis utilising Analytical Hierarchical Process (AHP). This approach
facilitates the fusion of all topic levels. For this study, a total of 12 distinct theme levels were
taken into account. The area's water flow.and storage are supposedly under the direction of these
12 thematic strata. According to the relationship between these contributing elements and
professional judgement, groundwater occurrence is given more weight. A high weight value
shows a layer with a large impact, while a low weight parameter shows a layer with little impact
on groundwater potential. Each parameter's weights were determined using Saaty's scale of
relative relevance values (1-9).

Table 8: Saaty’s Scale for Assignment and its Interpretation showing Pair-Wise Comparison
process [67,49].

Extremely 9
Less important Very Strongly | 7
Strongly 5
Moderately 3
Equally important Equally 1

Moderately 1/3
More Important Strongly 1/5
Very strongly | 1/7
Extremely 1/9

2,4, 6 and 8 are intermediate values.



Additionally, the weights were determined after reviewing earlier research and fieldwork.
According to the Saaty scale, a value of 9 denotes extreme importance, 8 indicates very strong
importance, 7 indicates very extreme importance, 6 denotes strong importance, 5 indicates strong
importance, 4 indicates moderate plus importance, 3 indicates moderate importance, 2.indicates
weak importance, and 1 indicates equal importance. According to the categorization, weights are
given to the thematic levels depending on their significance. In a pair-wise comparison matrix,

all of the thematic layers have thus been compared to one another (Table 9)

Table 9: Pair-wise comparison Matrix

Rf Si LST DD So LD TWI _LULC Normalized
Weight
Rf 1.00 4 5 3 2 033 5 6 0.25
Sl 0.25 1.00 5 5 3 2 5 0:33 0.15
LST 0.2 0.14 1.00 0.5 0.11 014 025 0.2 0.02
DD 0.33 0.2 2 100 6 0.2 033 0.25 0.07
So 0.5 033 9 0.17 1.00 3 0.5 0.2 0.16
LD 3 0.5 7 5 0.33° 100 4 0.5 0.17
TWI 0.2 0.2 4 3 2 0.25 1.00 0.33 0.07
LULC 0.17 3 5 4 5 2 3 1.00 0.18

SN
o

Total 5.65 9.37 2167 19.44 8.92 19.08 8.81

Consistency Index 0.07
Random Index 1.41
Consistency Ratio 0.05

Rf = rainfall; SI =.slope; DD = drainage density; So = soil; LULC = land use land cover; LD =
lineament density; TWI = Topographic wetness index; LST= Land surface temperature

Computation of the thematic layers' consistency ratio and priority ratings

The proportionate degree of each theme's effect on groundwater development was calculated to
increase the groundwater potential zone model's accuracy. A function for the matrix divergence
from consistency is represented by the primary characteristic value (Amax) [68]. Only when the

consistency ratio is equal to or less than 10% are the assigned weights deemed consistent;



otherwise, these weights must be reevaluated to reduce inconsistency [69]. The consistency

metric as shown in Eq. (10) was used to obtain the consistency index:

Anax—n

Cl =
n—1

Where
Amax IS the consistency measure and
n is the number of GWPZ factors.

The consistency ratio is calculated using Eq. (11) [67]:

_
" RCI

CR
where
Cl is the consistency index based on Eq. 10-and

RCI is the random consistency index obtained from'Saaty’s 1-9 scale [67].

10

11

As long as the consistency ratio is within the anticipated range, the final criterion weights that are

produced are regarded as the normalised values. The value of CR is anticipated to fall between

0.01 and 0.09 for a consistent normalisation; otherwise, the priority scores must be modified.

Table 10. Ratio index (RI) for various n scores [67].

N 3 4 5 6 7 8 9 10

Cl 0.58. |0.89 1.12 1.24 |1.32 141 1.45 | 1.49

Analysis of overlays for defining groundwater potential zones



As a summary of the components' actual influences based on their criteria weight to produce the
ultimate potential zone, the overlay analysis of the seven thematic layers was performed in
ArcGIS 10.5.1. All of the layers' units were rated when they were turned into an integral raster to

get at these. Eq. 12 was used to determine the groundwater potential zone.

GWPZ = Y"(X, % Yp) 12

where

GWPI is the groundwater potential index,
Wi is the criteria weight,
Ri is the ranking of parameter factors, and

i denotes each of the seven influencing factors with serial number from 1 to 7.

Validation of the prospective zone for groundwater

The National Groundwater Archive of the South African Department of Water Affairs’ data on
groundwater output from exploratory boreholes was used to validate the designated GWPZs. To
filter out the relevant grid code identification of the drill location, the 84 geo-referenced yield
data was superimposed on the GWPZ map. To simulate the predicted yield value, the regression
equation between the groundwater yield and the distribution diagram of the GWPZ grid codes
was determined. Microsoft Excel was used to compute the p-value for the association between
the observed value and the simulated value as well as the coefficient of determination (R2),
coefficient of correlation (R), and coefficient of correlation (R). Using Eg. (15), R was
calculated.

Results and Discussion

Soil

The type of soil formed in an area also plays an important role on groundwater recharge through
infiltration and loss through run-off. Sandy soils often allow increased infiltration because of



their higher permeability. The soil map of the study area is classified into seven soil categories,
viz., Clay loam, Concretionary clay, Loamy fine sand, Sandy soil, Sandy clay, Sandy loam and
Silty clay (Figure 2). Loamy fine sand soils occur in the northeastern parts of the study area,
whereas clayey loam soils mostly prevail in the middle areas. Sandy soils have a high percentage
of macro pores with faster water infiltration rates compared than loamy soils. Loamy soils which
own high percentages of middle size pores have higher infiltration rates than clayey soils which
have the highest percentage of fine size pores [70]. Large areas are covered by loam and clayey
loam soils and were assigned a high to intermediate priority in groundwater-potential-analysis.
Loamy sand and sandy soils were allocated a very high to extremely high weight.
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Figure 2: Map of the categories of soil features

Drainage density

The drainage density map was classified into four with areas of high concentration
surrounding. the river confluence where enormous groundwater discharge to the watercourse. The
four spots of high drainage density in the middle and at the North can be associated with the
existence-of water body. As a result, areas of higher drainage density are inversely ranked while
the area of very low drainage density is assigned a higher rank.
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Rainfall map

The spatial variation in rainfall intensity influences the distribution of groundwater recharge rate
across the study area. Due to the positive influence of rainfall on groundwater recharge, the areas
with higher rainfall range are ranked higher. The overall feature of the mean annual rainfall is
that it has the highest levels on the northern parts, of the study area. The five rainfall zones
defined in this study are 646 to 650, 650 to658, 658 to 666, 666 to 667 and 671 to 673 mm yr—1
(Figure 4). The opportunity of groundwater potential and recharge could be excessive in the

region where the rainfall is excessive and is low where rainfall is low [71].
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Lineament density map

The lineament density map is classified into five: the very high, high, moderate, and low/none
lineament density area (Figure 5). This aligns with the topographic complexity in the North
where the relief is steep and abrupt. Areas of extensive fracture system are replicated by high
lineament density [72]. Zones of higher lineament density are expected to have higher potential
for groundwater accumulation; hence, they are ranked higher. Lineaments, weak zones in the
landscape that facilitate the movement of groundwater, are an important theme for. GWPZs
mapping since they have considerable control over the movement of groundwater [73].*Fractures
in rocks enhance their secondary porosity and permeability and thus increase the groundwater
movement [74]. Areas with high lineament density in the present study denote permeable zones,
so reveal good groundwater potential zones.
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Topographic wetness index

TWI has been employed to decipher the average groundwater level in a watershed characterized
by low permeability soils [75]. The very low TWI that suggests the tendency for overland flow
was assigned the lowest rank while the very high TWI that indicates the tendency for soil
moisture accumulation zone was assigned the highest rank. The TWI showed high concentration
in the north and center and coincidence with the drainage density (Figure 6).
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Land use/land cover

The result of the LULC showed four classes, which are bare land, light forest, thick forest and
water body. The spatial distribution of the LULC have bare land (146051 ha), light forest
(197735 ha), thick forest (78083 ha) and water body (11815 ha) respectively. A mixed forest is a
naturally preserved environment and an important.indication.of groundwater potential. Water
bodies, thick forest and light forest are positive indicators of groundwater potential; hence, they
are ranked higher than others. Meanwhile, .bare land are the least important areas for
groundwater investigation. While surfaces. protected by vegetation, such as those covered in
agricultural plants and forests, have a better chance of groundwater opportunity due to higher
infiltration through trapping and protecting the rainwater in plant roots and cracks, bare land and
rocky surfaces have much‘less opportunity of groundwater potential prevalence through growing
runoff during rainfall {76,77,78].
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Figure 7: Map showing the factors of LULC

Land surface temperature

The land surface temperature map is classified into four: the very low, low, moderate, and high
as presented in Figure 8. Temperature ranges between 18°C and 36°C. Areas of low temperature
had the largest coverage (99109ha), followed by a moderate temperature class (140081ha), the
very low-temperature class (75271ha), and the least which is hot temperature class (119223ha).
The similitude in the geospatial attributes of LULC and LST further depicts the relative influence
of urbanisation in inducing urban heat index which indirectly culminates into the spatial
variability in land surface temperature. This, therefore, conforms-to the:findings of [79] on the
relationship between the LULC system and LST variability. Areas of high temperatures are
associated with a high evaporation rate. Evaporation is.a critical issue in a water-scarce country
like Nigeria, where it constitutes a significant soil moisture loss and diminution to shallow
unconfined aquifers. As a consequence, areas with high temperatures are assigned the lowest
rank while the areas with low temperatures.are assigned-the highest rank.
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Figure 8: Map showing the factors of Land surface temperature

Delineation of groundwater potential zone

Groundwater is a replenishable resource, but due to various kinds of anthropogenic activities and
skewed developments, recharge of this precious life sustaining resource has been reduced
significantly. The groundwater availability is not uniform in space and time and therefore,
detailed and accurate assessment of the groundwater resource is required. The parameters that



are considered here are slope, rainfall, LULC, LST, lineament density, drainage density, soil,
TWI. The weighted overlay method has been applied to generate the groundwater potential zones
in the study area. The resulted map is divided into very high, high, moderate, low and very low
groundwater potential zones and the aerial spread of these categories are 116005.5 ha, 35822.4
ha, 20152 ha, 2459 ha and 259245 respectively (Figure 9). The study shows that the groundwater
potential is high in the north eastern part of the study area and low in the south. The“potential
groundwater area lies in a perpendicular direction along the West-East direction to the.direction
of the catchment drainage. Overall, zones with high groundwater potential are dominant in the
north-east, while the extremely poor groundwater potential zone is dominant in the south and
south. This corresponds to the highly vegetated area of the land use/cover map (Figure 7) and the
highly dissected area shown by the drainage density map (Figure 3).
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Very high and high groundwater potential zones are confined generally to high rainfall
regions which in.turn have high infiltration potential. The moderate groundwater potential zones

occur generally in.the valleys and areas of high drainage density.

Ground Water Potential Zone Validation

Since agrarian communities predominate in the study area, borehole drilling remains a privilege
reserved for a select group of the communities' elites. As a result, the area's predominantly
farming population turned to dug-out wells for home usage, crop irrigation, and small-scale

agro-processing. For validation purposes, 43 functional wells were sampled. Our validation will



be limited to the spatial distribution of the sampled wells relative to the categories of the GWPZs
because of the absence of available data and the high cost of carrying out the yield capacity of
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Figure 10: GWPZ map showing the validation points.

Out of the 55 operational wells sampled (Figure 10), 72.73 % were situated in areas with very
high groundwater potential. The high category had 10.91% while the moderate, low and very
low categories remained 7.27%, 5.45% and 3.64% respectively (Figure 11).
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Figure 11: A bar chart showing the spatial distribution of wells inthe study area

According to the validation outcomes of the geolocated samples, there may be a very high degree
of agreement between groundwater inventory data.and groundwater potential zones established
using GIS and RS techniques. As-a. result, it was determined that the results of the weight
overlay analysis and the groundwater-potential maps supported by the AHP technique were very
precise forecasts.

Conclusion

It has.been shown how the geosciences technique, which combines geology data with
nonlinear, spatially independent environmental, hydrologic, and geomorphic parameters, can be
used to map the zones with the greatest potential for groundwater. The work's originality lies in
the parameters used and the conceptual processes used to reduce ambiguity and guarantee high
precision mapping. From the study, the following findings can be drawn: Overall, the
computational method used in this work can be applied to characterize groundwater potential
zones and places that need cautious use to prevent groundwater pollution based on the seven
factors used in any semi-arid or dry environment with comparable features.
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